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Legal Notices

Warranty
The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an 
additional warranty. HP shall not be liable for technical or editorial errors or omissions contained 
herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend
Confidential computer software. Valid license from HP required for possession, use or copying. 
Consistent with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software 
Documentation, and Technical Data for Commercial Items are licensed to the U.S. Government 
under vendor's standard commercial license.

Copyright Notice
© Copyright 1994-2013 Hewlett-Packard Development Company, L.P.

Trademark Notices
This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This 
product includes software written by Tim Hudson (tjh@cryptsoft.com). Smack software copyright 
© Jive Software, 1998-2004. SVG Viewer, Mozilla JavaScript-C (SpiderMonkey), and Rhino 
software Copyright © 1998-2004 The Mozilla Organization. This product includes software 
developed by the OpenSSL Project for use in the OpenSSL toolkit. (http:// www.openssl.org). 
OpenSSL software copyright 1998-2005 The OpenSSL Project. All rights reserved. This project 
includes software developed by the MX4J project (http://mx4j.sourceforge.net). MX4J software 
copyright © 2001-2004 MX4J Team. All rights reserved. JFreeChart software © 2000-2004, Object 
Refinery Limited. All rights reserved. JDOM software copyright © 2000 Brett McLaughlin, Jason 
Hunter. All rights reserved. LDAP, OpenLDAP, and the Netscape Directory SDK Copyright © 
1995-2004 Sun Microsystems, Inc. Japanese Morphological Analyzer © 2004 Basis Technology 
Corp. The Sentry Spelling-Checker Engine Copyright © 2000 Wintertree Software Inc. Spell 
Checker copyright © 1995-2004 Wintertree Software Inc. CoolMenu software copyright © 2001 
Thomas Brattli. All rights reserved. Coroutine Software for Java owned by Neva Object 
Technology, Inc. and is protected by US and international copyright law. Crystal Reports Pro and 
Crystal RTE software © 2001 Crystal Decisions, Inc., All rights reserved. Eclipse software © 
Copyright 2000, 2004 IBM Corporation and others. All rights reserved. Copyright 2001-2004 Kiran 
Kaja and Robert A. van Engelen, Genivia Inc. All rights reserved. Xtree copyright 2004 Emil A. 
Eklund. This product includes software developed by the Indiana University Extreme! Lab (<http:// 
www.extreme.indiana.edu/>). Portions copyright © Daniel G. Hyans, 1998. cbg.editor Eclipse 
plugin copyright © 2002, Chris Grindstaff. Part of the software embedded in this product is gSOAP 
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software. Portions created by gSOAP are copyright © 2001-2004 Robert A. van Engelen, Genivia 
Inc. All Rights Reserved. Copyright © 1991-2005 Unicode, Inc. All rights reserved. Distributed 
under the Terms of Use in http:// www.unicode.org/ copyright.html.

Adobe™ is a trademark of Adobe Systems Incorporated.

Java™ is a registered trademark of Oracle and/or its affiliates.

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.

Oracle® is a registered US trademark of Oracle Corporation, Redwood City, California.

UNIX® is a registered trademark of The Open Group.

For a complete list of open source and third party acknowledgements, visit the HP Software 
Support Online web site and search for the product manual called HP Service Manager Open 
Source and Third Party License Agreements.
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Documentation Updates
The title page of this document contains the following identifying information:

 l Software Version number, which indicates the software version.

 l Document Release Date, which changes each time the document is updated.

 l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go 
to:

      http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport 
ID, go to:

      http://h20229.www2.hp.com/passport-registration.html

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support 
service. Contact your HP sales representative for details.
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Support
Visit the HP Software Support Online web site at:

      http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support 
that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. As a 
valued support customer, you can benefit by using the support web site to:

 l Search for knowledge documents of interest

 l Submit and track support cases and enhancement requests

 l Download software patches

 l Manage support contracts

 l Look up HP support contacts

 l Review information about available services

 l Enter into discussions with other software customers

 l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also 
require a support contract. To register for an HP Passport ID, go to:

      http://h20229.www2.hp.com/passport-registration.html

To find more information about access levels, go to: 

      http://h20230.www2.hp.com/new_access_levels.jsp
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This document is an overview of the changes made to HP Service Manager 9.21 for patch 8. It 
contains important information that is not included in other documentation. 
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What's New in This Release
This section describes important changes in this release.

Important:              Based on customer feedback, the overall quality of Service Manager has been an 
area of concern over the last number of years. To that end, the Service Manager R&D team 
has spent a significant amount of effort improving the quality of Service Manager, and recent 
customer feedback is very positive. Many defects that have been in the product for many years 
are now fixed in the SM 9.3x. The issues resolved in this build patch cover only the most 
critical fixes.  To gain better performance and user experience, we strongly recommend that 
you apply the latest binaries from SM 9.3x instead of this build patch.

    In most cases SM 9.3x binaries are compatible with SM 7.1x and SM 9.2x applications. 
Therefore,  you are not required to perform a full upgrade to take advantage of the latest Service 
Manager technology.  Specific compatibility details are listed in the SM 9.3x release notes.         

Warning when running the server on Solaris 9 with 
JRE 6

In SM9.21 P7, the server's JRE version was upgraded to JRE7. When Service Manager started, it 
performed a JRE validation that did not allow a JRE version below JRE7 update15. However, 
JRE7 is not supported by Solaris 9. Therefore, SM9.21 P7 could not start on Solaris 9-based 
systems. 

As of version 9.21 P8, the Service Manager server is allowed to run with JRE 1.6.0_20 or later on 
Solaris 9. However, HP recommends that you upgrade to Solaris 10 to take advantage of JRE 7. 
When you start the SM server on Solaris 9, a warning will display: "Service Manager runs on 
Solaris 9 with jre6 as Solaris 9 does not support jre7. We recommend you to run 
on Solaris10 with jre7."

Extra configuration required for Solaris 9

If you still want to run the server on Solaris 9, be aware that an extra configuration is required. 
Without this configuration, when you start the SM server on Solaris 9, the following error will occur: 
"fatal: libm.so.2: open failed: No such file or directory." This is  because there is no 
"libm.so.2" on Solaris 9, while the SM server requires this "libm.so.2" to work.

Use the following configuration to avoid this issue:

 1. Log on to the Solaris 9 server host as root.

 2. Run the following commands to create a link between libm.so.1 and libm.so.2: 

cd /usr/lib 

ln -s libm.so.1 libm.so.2
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 3. Set environment variable: LD_NOVERSION=1 export LD_NOVERSION

 4. Start the SM server. The server is started successfully.

Patch/hotfix level included in version information
Previously, the sm -version RTE command returned only the version string and build number. 
After you apply Service Manager 9.21p8, the command also returns the exact patch or hotfix level 
(for example, P8).

Obsolete threadstacksize parameter removed
The obsolete threadstacksize parameter is removed from the "sm -helpthreading" command output. 
In versions of Service Manager earlier than 9.21p8, this parameter is displayed when you run the 
command. However, the parameter has no effect and is ignored. It will continue to be ignored. See 
"QCCR1E88441" on page 11.

New Parameters and RAD Functions
This release has introduced or updated the following  parameters.

 l "Parameter: maxpagesize (new)" below

 l "Information retrieval (IR) expert parameter: ir_sql_limit (updated)" on the facing page

Parameter: maxpagesize (new)
Parameter

maxpagesize

Description
This parameter defines the maximum number of records that the Windows client requests from 
the server when displaying a record list. It helps to avoid high memory consumption by getList 
requests when the "Record list request count" option in the Windows client preferences is set to 
a large value.

Valid if set from
Server's OS command prompt
Initialization file (sm.ini)

Requires restart of the Service Manager server?
No (only requires a re-login)

Default value
8000

Possible values
0: No size limit
8000 to 80,000
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Example usage
Command line: sm -httpPort:13080 -maxpagesize:10000
Initialization file: maxpagesize:10000

Information retrieval (IR) expert parameter: ir_sql_
limit (updated)

Parameter
ir_sql_limit

Description
This parameter  determines the maximum number of records to be fetched from the RDBMS in a 
combined IR and SQL query. 

This parameter does not affect pure IR queries (queries that only involve IR indexed fields) or 
pure SQL queries. It only affects queries that involve some fields that are indexed by IR and 
some that are not.

Valid if set from
Server's OS command prompt
Initialization file (sm.ini)

Requires restart of Service Manager server?
Yes

Default value
32767

Possible values
The maximum number of records to be fetched from the RDBMS for a combined IR and SQL 
query. A value of 0 (zero) means there is no limit.

Example usage
Command line: sm -httpPort:13080 -ir_sql_limit:20000
Initialization file: ir_sql_limit:20000

Certifications
This release includes the following support matrix changes.

Added support

 l SM server platform: JRE 1.6.0_20 or later (with Solaris 9)

Discontinued support

 l Web tier application server: IBM WebSphere Application Server 6.1 (due to its end of life)

See also the compatibility matrix for Service Manager 9.21 on the Software Support Online (SSO) 
site:http://support.openview.hp.com/sc/support_matricies.jsp

HP Service Manager (9.21) Page 10 of 43

Patch 8 Release Notes
What's New in This Release

http://support.openview.hp.com/sc/support_matricies.jsp


Fixed Defects
This release fixes the following defects.

Server
CR Problem Solution

QCCR1E61586 When you set an autoformat condition on a view 
using the operator "Is Empty", the condition is not 
considered.

"Null" conditions are now supported for Autoformat 
views.

QCCR1E88327 RTE Signal 11 occurs when running the 
"xml.setContent" js function.

Signal 11 does not occur when running the 
"xml.setContent" js function.

QCCR1E88441 When you run the sm -helpthreading command, 
the obsolete threadstacksize parameter is still 
displayed.

This parameter is no longer returned when users run the 
sm -helpthreading command.

QCCR1E89108 When you execute JavaScripts that call 
doSOAPRequest() or doHTTPRequest(), a large 
number of error messages is logged in the sm.log 
file. 

The error messages are no longer generated.

QCCR1E91369 Inboxes cause signal 11 errors, which lead to high 
memory usage. 

Inboxes no longer cause signal 11 errors and hence high 
memory usage does not occur.
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CR Problem Solution

QCCR1E91996 The Service Manager documentation describes 
the default value of the "agstackl" parameter as 
400. The correct value is 600.

The default value has been updated to 600 in the "sm -
helpstart" command output.

Note: The online help has not been updated. See 
"Documentation Errata" on page 22.

QCCR1E92564 The incident matching feature performs slowly 
when security folders are enabled.

The incident matching performance is no longer 
impacted by security folders.

QCCR1E93394 The "autodebughttp" parameter that is referenced 
in the RTE code is not an 'official' parameter.

The reference to the "autodebughttp" parameter is 
removed from the code.

QCCR1E94107 A servlet, usually a servlet for Webservice 
requests, crashes multiple times a day. 

The servlet does not crash when a session expires.

QCCR1E94700 Low memory issues occur in the CIT servlet in 
Service Manager Application.

No memory leak occurs when RCString is read.

QCCR1E95074 When the "Record list request count" option is set 
to a large value (for example, 1,000,000) in the 
Windows client preferences, high memory usage 
occurs.

 

A new parameter (maxpagesize) is introduced to avoid 
high memory consumption by one getList request when 
the "Record list request count" option is set to a large 
value.

For more information, see "Parameter: maxpagesize 
(new)" on page 9.

QCCR1E95484 When you import unload files, memory leaks 
occur.

No memory leaks occur when you import unload files.

QCCR1E95796 The search results form of a Query-by-Example 
(QBE) list is unnecessarily refreshed because the 
listid is updated incorrectly.

The search results form of a QBE list is refreshed only 
when necessary.
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CR Problem Solution

QCCR1E96102  The ir_sql_limit parameter does not take effect for 
a merged file, causing inconsistent and 
unexpected IR search results when searching 
Incidents using a combined IR and SQL query.

Now the ir_sql_limit parameter takes effect for a merged 
file. Furthermore, now you can configure ir_sql_limit:0 to 
fetch all the rows from the RDBMS for the IR query.

For more information, see "Information retrieval (IR) 
expert parameter: ir_sql_limit (updated)" on page 10.

QCCR1E96157 When the KMUpdate process fails, incremental 
updates do not continue.

Incremental updates continue if the KMUpdate process 
fails.

QCCR1E96284 The following message is received:

The record being updated has been 
modified since read when saving around 
10% of operator records.

From the log trace, it looks like the operator 
capability array is truncated. This only occurs in 
an environment where the binaries have been 
upgraded to 9.31.2018. If you restart the same 
server, using the backed up 9.30.282 binaries, 
you are able to save the record without the 
warning message.

This issue was caused by the attempt to remove those 
capabilities merged from the template record when a 
templatized record became non-templatized (see 
QCCR1E32145). After this fix, the capabilities that came 
from the template record will remain unchanged.

QCCR1E96925  Service Manager experienced two separate 
outages in one day, in production, using 9.21 P6 
HF3 binaries for the server and web tier. The SM 
server runs on Solaris 10, and WebSphere runs on 
RHEL.

Each time the outage happened, all users were 
kicked out of the system, and new logins were not 
allowed for a period of about 10 minutes. A 
recycle of SM was not needed, for the system to 
start accepting new logins again.

Service Manager will not experience outages, and users 
will not be kicked out because of outages.
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CR Problem Solution

QCCR1E97003 You cannot run a vrir command on external IR 
files.

You can successfully run a vrir command, whether the 
input file is the full path of the IR file or the file name with 
its path set in the ir_prefix parameter.

QCCR1E97612 You cannot identify the patch or hotfix information 
from the RTE log or from the sm -version RTE 
command. The sm -version RTE command 
displays the version string and build number, but 
you cannot determine which patches or hotfixes 
are applied from this information.

When you run the sm -version RTE command, the exact 
patch level (for example, P2HF2) is displayed.

QCCR1E97699 When number files are used, a memory leak 
occurs.

No memory leak occurs when number files are used.

QCCR1E98273 Memory corruption occurs when you execute a 
system_unload command.  

The memory corruption does not occur.

QCCR1E98497 When an extremely long query is run, a buffer 
overrun occurs and the memory next to the buffer 
is overwritten.

The issue in which memory is overwritten is fixed by 
adding the necessary checking logic.

QCCR1E99380 The survey integration sends out garbled surveys 
to French users.

Now the correct charset is added to the Content-Type 
HTTP header if the charset is not provided, so that the 
receiver can decode the body with the correct charset.

QCCR1E99520 The user session gets terminated when searching 
incidents using the Advanced Filter (for example, 
Title Contains printer).

The user session is no longer terminated.
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CR Problem Solution

QCCR1E99940 SM7.11 P21, SM9.21 P7, and SM9.31 P2 
upgrade the JRE version to JRE7. When Service 
Manager starts, it performs a JRE validation that 
does not allow a JRE version below JRE7 
update15. However, JRE7 is not supported by 
Solaris 9. Therefore, Service Manager does not 
start on Solaris 9-based systems.

Service Manager now can run with JRE 1.6.0_20 or later 
on Solaris 9-based systems.

QCCR1E100275 Adding the parameter ir_language:french in sm.ini 
causes shared memory corruption.

Adding the parameter ir_language:french in sm.ini no 
longer causes shared memory corruption.

Web Client
CR Problem Solution

CCR1E61586 When you set an autoformat condition on a 
view using the operator "Is Empty", the 
condition is not considered.

Add the support for "Null" condition of Autoformat view.

QCCR1E76272 In a customer's production environment 
sometimes Tomcat memory suddenly spikes 
and then exceeds available memory when 
certain Change records are viewed in Web 
client. This problem neither occurs with all 
Change records nor occurs in a test or 
development environment with the same 
records.

By the timely releasing of Java heap memory, now the memory 
usage by the Web tier in an application server will not exceed the 
limits.

QCCR1E84238 MySM does not work with two-level structure 
configured on Tomcat context path.  

MySM can work with two-level structure configured on Tomcat 
context path.

QCCR1E87922  Users cannot get the data when opening a new 
window in the Incident Home Page of MySM.

Users can get the data when opening a new window in the 
Incident Home Page.
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CR Problem Solution

QCCR1E90797 The date/time picker for the Start Time or the 
End Time field is missing when the field has a 
value.

The date/time picker is now visible when the field has a value.

QCCR1E91012 After a new change task is saved, the 
date/time picker for the start time and the end 
time in the work notes group disappears if 
values are provided for these two fields.

After a new change task is saved, the date/time picker for the 
start time and end time in the work notes group does not 
disappear if values are provided for these two fields.

QCCR1E91577 When setting "attributes and values" for 
"Expected States" of a Configuration Item 
(CI), if the type of the first field is array-of-
datetime, the following array-type fields will 
also be displayed as array-of-datetime type.

When setting "attributes and values" for "Expected States" of a 
Configuration Item (CI), all array-typed fields are displayed 
correctly.

QCCR1E93281 Error "invalid query hash in URL" occurs when 
clicking OK on the filter of the Incidents Bar 
Chart component in MySM.

The error no longer occurs when clicking OK on the filter of the 
Incidents Bar Chart component in MySM.

QCCR1E94087 If you insert extra white spaces between the 
words of a field caption through Database 
Dictionary and then try to add this field to an 
existing Inbox view in the web client, the web 
page enters an infinite loop of refresh.

Now you can successfully add a field to an existing Inbox view 
without any problems when the field caption contains extra 
spaces (for example, two spaces between Downtime and Start in 
caption "Scheduled Downtime Start").

QCCR1E96246 When you view the User Selections of a 
catalog item in the Service Manager web 
client, the input field is too small for you to 
enter text if a long name is used for the label.

When you view the User Selections of a catalog item in the 
Service Manager web client, the input field remains the same size 
if a long name is used for the label.

QCCR1E96430 The Web client freezes when trying to display 
a page with a ListBuilder widget, if the 
ListBuider selection contains the character ‘&’.

The Web client displays a page with a ListBuilder widget even if 
the ListBuider selection contains the character ‘&’.
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CR Problem Solution

QCCR1E96406 The Count button does not work when the 
Include Value list of a security group contains 
long double-byte strings.

The Count button works as expected when the Include Value list 
of a security group contains long double-byte strings.

QCCR1E96752 The container that holds the description of a 
catalog item does not resize with the object 
that it contains.

The description field fits the size of the container.

QCCR1E96909  MySM popups are launched with HTTP 404 
errors or without images when you configure a 
two-level structure for the Tomcat context 
path.

MySM popups are launched with the right records, and you can 
view the images.

Note: After applying this fix, you do not need workaround 
QCCR1E84238. If you have applied it, you need to remove 
it. Additionally, you need to clear your browser cache before 
you log in.

QCCR1E97272  A JS error regarding the "showLastMessage" 
function displays in the browser console of the 
new window after you click the "Open a New 
Window" button on a MySM component.

The JS error no longer occurs in the console after you click the 
"Open a New Window" button on a MySM component.

QCCR1E97539 If your browser uses JRE, and you upgrade 
JRE to version 1.7.0_21 or later, the following 
warning message is prompted when you open 
a configuration item in SM web client with the 
browser:

"Block potentially unsafe components 
from being run?"

To resolve this issue, affected applets have been repackaged in 
the web tier.

Note: Even after the applets are repackaged, a security 
prompt with a blue information will appear. To avoid the 
security prompt, check the “Do not show this again…” 
checkbox and then click Run. For detailed information, see: 
http://support.openview.hp.com/selfsolve/document/KM006
60753
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Windows Client
CR Problem Solution

QCCR1E29823 Assume that the first element in an array field 
contains a value. When you enter a value in the 
second element and perform a Fill action, the 
second element is populated with the value of 
the first element.

However, if you then click to move the cursor 
out of the second element, the value reverts to 
the correct value.

Assume that the first element in an array field contains a 
value. When you enter a value in the second element and 
perform a Fill action, the second element is populated 
with the correct value.

QCCR1E58026 When opening a configuration item, by default 
the focus is set to the Relationship Graph 
section.

When opening a configuration item, by default the focus 
is set to the Details section.

QCCR1E94930 When you try to close one of the open windows 
in the Windows client by using the File > Exit 
menu, all windows are closed. You can only 
close a single window by clicking the "close" 
button on the upper right corner of the window.

When multiple windows are open in the Windows client, 
the click of the File > Exit menu only closes the current 
active window.
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CR Problem Solution

QCCR1E95200  The following message box appears in the 
Windows client  when you switch selection in 
the Connection Configuration list:

The configuration *** has unsaved 
changes. Do you wish to save them?

This issue only occurs when you switch from a 
Connection Configuration with the "Remember 
my password" check box checked, even though 
there are no unsaved changes.

When you switch selection in the Connection 
Configuration list the "Save Changes" message box will 
not appear if there are no unsaved changes.

QCCR1E95547 The startup.jar file does not exist in the Client 
folder after the installation of the Windows 
client.

If you run the  Client Configuration Utility and 
input Directory as "C:\Program 
Files\HP\Service Manager 9.21\Client", when 
you click the Next button, the utility reports the 
following error message:

"File does not exist: C:\Program 
Files\HP\Service Manager 
9.21\Client/startup.jar."

The startup.jar file is no longer needed. After removing 
the startup.jar validation, the  Client Configuration Utility 
runs successfully without any errors.

QCCR1E95895 You cannot open attachments with long names 
in the Windows client.

You can successfully open attachments with long 
names in the Windows client.
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CR Problem Solution

QCCR1E97227 If the operating system (OS) date format is set 
to Chinese (PRC), the Windows client does not 
display the Chinese names of the days of the 
week (such as Monday) completely in the pop-
up calendar window for a date/time field. It 
displays only the first two Chinese characters.

If the OS date format is Chinese, the Windows client 
now displays only the last Chinese character (one, two, 
three, and so on) of each day of the week in the pop-up 
calendar window.

Note: The Windows client now displays the 
navigation menu (System Navigator) based on the 
OS display language instead of the OS date format. 
For example, if the display language is English, the 
menu will display in English even if the date format 
is Chinese.

QCCR1E97968  Obvious performance drop when viewing CIs in 
the Windows client.  

The performance remains high when viewing CIs in the 
Windows client.

QCCR1E98185 When modifying the Font Increase property of a 
Wrap label widget in the Design mode of Forms 
Designer, if you enter a negative value whose 
absolute value exceeds the standard font size or 
if you enter an invalid value (such as letter "a"), 
the client window gets locked.

In this case, the client window no longer gets locked; 
instead, an error message displays and the original Font 
Increase value is kept.

QCCR1E98262  It is no longer possible to move Button widgets 
in Forms Designer using the keyboard arrow 
keys. 

User can move Button widgets in Forms Designer using 
the keyboard arrow keys.

QCCR1E98323 The JRE version for the Client Configuration 
Utility is still JRE1.5.0_11.

The JRE version for the Client Configuration Utility is 
upgraded from JRE1.5.0_11 to JRE 1.7_45.
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Known Problems, Limitations, and Workarounds
The following table lists the known issues discovered in this release.

Global ID Known Issue Workaround

QCCR1E89890 Grouped Views are not correctly updated after logging a new 
incident.

When you log a new incident, to keep consistency with 
actual incidents, the group number is not updated. 

You need to click the Refresh button to update 
grouped Views.

QCCR1E72809 After closing a ticket (such as an Interaction or Incident) and 
returning to the view, the queue is not synchronized correctly.

As a workaround, click the Refresh button to solve the 
view display issue.
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Documentation Errata
The following documentation item is incorrect. 

Location:

Online help: Help topic "Startup parameter: agstackl"

Error: :    

The default value of this parameter is 400.

Correction:

The default value of this parameter is 600.
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Backout Instructions
If you want to restore your Service Manager system to its original state after installing this patch, 
follow these guidelines.

Server
To backout your server changes, make a backup before installing the patch and then roll back.

Backup
Before applying the server patch, make a backup of the server installation folder. For example, 
C:\Program Files\HP\Service Manager 9.21\Server.

Note: If you have a load balanced system, be sure to back up the server installation folder for 
every server instance respectively.

Backout
To restore your Service Manager server to its original state after installing the patch, do the 
following:

 1. Stop the Service Manager server.

 2. Remove the existing server installation folder.

 3. Copy the backup folder back.

Note: Make sure that the embedded Tomcat is also replaced with the backup as the 
version of the embedded Tomcat may have dependency with specific server version.

 4. Restart the Service Manager server.

Note: If you have a load balanced system, make sure that every server instance is replaced 
with its respective backup.

Web Tier
Backup

Before deploying the new web tier, make a backup of the following items:

 l web.xml file

 l application-context.xml
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 l splash screen

 l style sheets

 l any other customizations you made, including your webtier-9.21.war (webtier-ear-9.21.ear) file.

Backout
To roll back to the old web tier:

 1. Delete or uninstall the existing web tier.

 2. Clear the cache of your web application server (for example, Tomcat).

 3. Redeploy the old web tier.

 4. Restore your old customizations.

Windows Client
To roll back to your old Windows client, you need to do backup before installing the new Windows 
client and then reinstall the previous Windows client.

Backup

 1. Make a backup of your Windows client home folder, for example, 
C:\Users\<username>\ServiceManager. Your connections and personalized settings are 
stored in this folder.

 2. Make a backup of your security configuration files if any (Window > Preferences > HP 
Service Manager > Security). For example, your CA certificates file and client keystore file.

Backout

 1. Uninstall the new Windows client.

 2. Reinstall the previous Windows client.

 3. Restore your old Windows connections and configurations.

Applications
Backup

Tip: If your application version is 7.11 ap3, 9.21 ap3, 9.30 ap3, 9.31 or later, you are 
recommended to use Unload Manager to make a backup of the files to be modified by an 
unload file, because Unload Manager can create a backup of your old data during the 
installation of the unload; if your application version is other than any of these, Unload Manager 
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is not available and you can use Database Manager instead. 

To use Unload Manager to make a backup:

 1. Go to System Administration > Ongoing Maintenance > Unload Manager.

 2. Double-click Apply Unload. A wizard opens.

 3. Select the unload file you want to apply, also specify a backup file, and then click Next.

Details of the unload file appear.

 4. Double-click a conflicting object in the table to open the merge tool:

 a. Merge the object, and then select the Reconciled check box.

 b. Click Save to go back to the wizard.

 5. Click Next after all the conflicting objects are reconciled.

 6. Click Yes on the confirmation window to apply the unload.

 7. Click Finish. 

Now, the unload has been applied and at the same time your old data backed up.

To use Database Manager to make a backup:

 1. Go to Database Manager, select Import/Load from More or the More Actions menu, and 
browse to the unload file.

 2. Click List Contents on the menu bar, to view a list of files that have been updated in this 
unload.

See the following figure for an example.

HP Service Manager (9.21) Page 25 of 43

Patch 8 Release Notes
Backout Instructions



This figure shows the contents of an unload file that contains changes to the following files:

File Record

Process     svc.add.cart

application money.format

Note: The scmessage records listed under each RAD application are 
messages used in this RAD application; no backup is needed for them.

ScriptLibrary svcCartHelper

datadict activity

dbdict activity

Note: The “activity” file with no records actually represents the dbdict 
record of the activity file.

scmessage The record whose message class is “fc” and message number is 1000. 

 3. Go to Database Manager, in the Table field enter a file name you got in step 2, and click the 
Search button.

 4. If the format selection page shows, select the proper format by double-clicking it (for example, 
select the device format for the device file), and then search for the file record.
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 5. Click More (or the More Actions menu) > Export/Unload after the file record displays.

Note: If Export/Unload is not available, check the Administration Mode check box in 
Database Manager and try again.

 6. In the pop-up window, specify your backup upload file path/name, and click Unload Appl. 

Caution: Make sure that Append to file is selected.

 7. Repeat steps 3 through 6 to back up the rest of the files you got in step 2.

Backout

Tip: You can use Unload Manager (recommended) or Database Manager (if Unload Manager is 
not available in your application version) to roll back to your old data, as described in the 
following.

To roll back to your old data using Unload Manager:

 1. Go to  System Administration > Ongoing Maintenance > Unload Manager.

 2. Double-click Apply Unload.

A wizard opens.

 3. Select the unload file generated in the backup process, specify a backup file, and then click 
Next.

Details of the unload file display.

 4. Double-click a conflicting object in the table to open the merge tool:
 a. Merge the object, and then select the Reconciled check box.

 b. Click Save to return to the wizard.

 5. Click Next after all the conflicting objects are reconciled.

 6. Click Yes on the confirmation window to apply the backup unload.

 7. Click Finish.

To roll back to your old data using Database Manager:

 1. Go to Database Manager, click More > Import/Load.

 2. Browse to the backup unload file you created.
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 3. Click Load FG.
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Installation Notes
This section provides instructions on installing each component in this patch release.

Digital Signature Notice
HP signs Windows executable files with a digital signature. Since January 2012, this process has 
been updated to use a new VeriSign root certificate. On a Windows system that does not have the 
new VeriSign root or intermediate certificate installed, when the user right-clicks the file and then 
goes to Properties > Digital Signatures > Details, a verification error will display: “The certificate 
in this signature cannot be verified.”

To resolve this issue, either enable Windows Update or download and install the G5 Root certificate 
as documented at: https://knowledge.verisign.com/support/ssl-certificates-
support/index?page=content&actp=CROSSLINK&id=SO19140

Web Tier Installation
The Web Tier update consists of a compressed file, sm9.21.661-P8_Web_Tier.zip. The specific 
upgrade process depends on your particular Web application server, but follows the same steps as 
deploying a new installation. For more information, refer to the Service Manager Interactive 
Installation Guide.
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The upgrade does not automatically save your Web Tier customizations. To keep your changes, 
you must save your customized files and replace the new version of these files with your 
customized version.

Note: The Service Manager introduces important changes to the Web tier Directory structure 
since SM 9.21 Patch 5 release. For more information on these changes, see the release notes 
of SM 9.21 Patch 5 and the “Updates to the Service Manager Web Tier Directory Structure” 
white paper at the HP Software support Web site: www.hp.com/go/hpsoftwaresupport

To install the new Web Tier:

 1. Make necessary backups. For details, see "Backout Instructions" on page 23.

 2. Delete or uninstall the existing webtier-9.21.war (or the webtier.ear-9.21.ear) file.

 3. Clear the cache of your web application server (for example, Tomcat).

 4. Deploy the new webtier-9.21.war (or the webtier.ear-9.21.ear) file following the instructions in 
the Service Manager Installation Guide.

Note:  

 n It is recommended to enable HTTPOnly cookies in your web application server to help 
prevent malicious JavaScript injection. To  enable HTTPOnly cookies, see Enabling 
HTTPOnly cookies in your Web Application Server.

 n It is best practice to deploy with a unique context root. For example: /webtier-
9.21.661

 5. Use a diff utility to compare the new Web tier’s web.xml file against your backed-up version to 
ensure that any new parameters are properly merged into the files used in your final 
deployment. Do this for application-context.xml as well as any other files you may have 
customized (such as style sheets and splash screens).

 6. Make any new customizations necessary for your deployment.

Note: Be sure to set the securelogin and sslport parameters.

 7. Restart the web application server.

Note: Before accessing the new Web Tier, HP recommends that all users empty their 
browser cache.

Enabling HTTPOnly cookies in your Web Application Server
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It is recommended to enable HTTPOnly cookies in your web application server to help prevent 
malicious JavaScript injection. Following are some examples for how to enable HTTPOnly cookies 
in different web application servers:

Web Application 
Server How to Enable  'HTTPOnly' Cookies

Tomcat 6.0.20+ Can be enabled for all web applications in conf/context.xml: 

<Context useHttpOnly="true"> ... </Context>  

Oracle WebLogic  
9.2 MP4, 10.0 
MP2, and 10.3.1

Enabled by default.

Oracle WebLogic 
10.3.0

You need to apply a security patch (p8176461_103_Generic), and after that 
HttpOnly cookies are enabled by default. The security patch can be 
downloaded using My Oracle Support (MOS). 

JBoss 5.1 Enable by setting useHttpOnly=true in the context.xml file, which is located 
in jboss/server/<myserver>/deploy/jbossweb.sar/.

<Context cookies="true" crossContext="true">
   <SessionCookie secure="true" httpOnly="true" />
       

</Context> 
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Web Application 
Server How to Enable  'HTTPOnly' Cookies

IBM WebSphere  
7.0.0.27

Enable through the following properties:

 l com.ibm.ws.security.addHttpOnlyAttributeToCookies 

 l com.ibm.ws.webcontainer.httpOnlyCookies

Known issue:

If Service Manager 9.21 is deployed on WAS 7.0.0.27, and FireFox is used 
to search "Approved Document" in the Knowledge Management module, 
you may encounter automatic logout issue.

Follow these steps to fix this issue by removing the incorrect URL for the 
background-image used for the knowledge document:

 1. Log on to the Windows client.

 2. From the Navigation menu, click Knowledge Management > Manage 
Document Types.

 3. Select the Reference record.

 4. Modify the Default View from the Associated Document View view 
list.

 5. Remove the incorrect URL in the CSS class .documentTitle. For 
example, remove the following: 

url("44ee44677b0f021810318488:kmrtBackground.gif:
 kmattachments:2").

 6. Save the change.

 7. Do the same for the other four records to avoid other similar problems.

IBM WebSphere 
8.0.0.5 

Enabled by default.

Windows Client Installation
The Windows client update consists of a compressed file, sm9.21.661-P8_Windows_Client.zip, 
which contains the executable installation files.

To install the Windows client update:
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 1. Stop the Service Manager Windows client.

 2. Make necessary backups. For details, see "Backout Instructions" on page 23.

 3. Uninstall the Service Manager Windows client. (Your connection and personalized settings are 
retained.)

 4. Run setup.exe and install the client by following the instructions in the Service Manager 
Installation Guide.

 5. Check the version in Help > About Service Manager Client.

The client should be Release: 9.21.661.

Windows Client Configuration Utility Installation
Service Manager 9.21p8 includes an updated version of the Windows Client Configuration Utility 
(sm9.21.661-P8_Windows_Client_Configuaration.zip), where the embedded JRE has been 
upgraded. It is intended only for customers who have upgraded their Windows client to version 
9.21p8 (or later).

For detailed installation instructions, see the Service Manager 9.20 Installation Guide, which is 
available from the HP Software Manuals Site: 

http://support.openview.hp.com/selfsolve/document/KM912628

Server Update Installation
The server update for your operating system (OS) consists of a compressed file, sm9.21.661-P8_
<OS>.zip (or .tar), which contains the Service Manager server files. These files add to or replace 
the files in the [SM Server Root]\ ([SM Server Root]/) RUN, irlang, 
legacyintegration, and platform_unloads directories.

Note: If you have a load balanced system, you must upgrade all server instances.

Caution: This server update will upgrade the embedded Tomcat to version 6.0.36, and 
therefore requires additional steps.

Note: The SM9.21p8 server requires JRE 1.7 (except for Solaris 9).  For Windows and Linux,  
the embedded JRE has already upgraded to version 1.7; for other Unix-based platforms, you 
need to manually perform this JRE upgrade.

The JRE upgrade will cause external web service calls over SSL to fail if the remote endpoint 
does not support Server Name Indication (SNI), which is by default activated in JRE 1.7. Once 
Service Manager is upgraded to use JRE 1.7, it starts to use SNI extensions during the SSL 

HP Service Manager (9.21) Page 33 of 43

Patch 8 Release Notes
Installation Notes



handshake. If the remote endpoint does not support SNI, the web service call will fail with an 
error message. To solve this issue, do either of the following: 

 l Activate SNI at the remote end point (recommended)

 l If the remote endpoint does not support SNI extensions, and SNI cannot be activated, add 
the following JVMOption<n> parameter either to the sm.ini file, or to the start command of 
the servlet(s) in the sm.cfg file:

JVMOption2:-Djsse.enableSNIExtension=false

To install the Server update:

 1. Stop all Service Manager clients.

 2. Stop the Service Manager server.

 3. Make a backup of the Server installation directory. See also "Backout Instructions" on page 23.

 4. Delete the RUN/tomcat directory. Tomcat in this directory will be upgraded to version 6.0.36 
when you extract the server files later.

 5. Delete the RUN/lib directory.

 6. For Windows and Linux platforms, delete the RUN/jre directory. 

Note: This step is required only when you are upgrading from a server version earlier than 
9.21p7. This is to avoid conflicts between the old 1.6-based JRE and new 1.7-based JRE.

 7. Extract the compressed files for your operating system into the main Service Manager 
directory on the server. The default path is: C:\Program Files\HP\Service Manager 
9.21\Server.

 8. For UNIX servers, set the file permissions for all Service Manager files to 755.

 9. For UNIX servers other than Solaris 9, manually upgrade to JRE1.7.

Note: Solaris 9 does not support JRE7. You can run the SM server on Solaris 9 with only 
JRE 1.6.0_20 or later.
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 a. Install either JDK1.7 or JRE1.7 for your specific platform.

Solaris 10 JRE1.7 (update 15  or greater)

HP-UX JRE1.7 (JRE_7.0.04 or greater)

AIX JRE1.7 (SR4 or greater)

 b. Set your JAVA_HOME environment variable to point to JDK1.7 (if you have 
JDK1.7 installed) or JRE1.7 (if you have only JRE1.7 installed).

 c. Execute \RUN\removeLinks.sh to remove the old symbolic links and then execute 
\RUN\setupLinks.sh to create new symbolic links. 

 d. Run the following command to check that the JRE version is 1.7: 

RUN\jre\bin\java –version

 10. If you have made any customizations/changes to the original RUN/tomcat folder, restore them 
in the new RUN/tomcat folder.

 11. Make sure the server is stopped, and run the sm -unlockdatabase command.

Note: The purpose of this step is to prevent stale license information from being kept in 
the system. In a scaling implementation, you can run this command from any one of your 
servers.

Caution: This step is required the first time you upgrade to 9.21p6 or later; it is also 
required whenever you change the server’s IP address after your upgrade to 9.21p6 or 
later.

 12. Restart the Service Manager server.

 13. Restart the Service Manager clients.

 14. Check the version in Help > About Service Manager Server. The server should be Release: 
9.21.661.

Application Unload Installation
If a platform fix (in most cases, a server fix) also requires an applications change to resolve the 
relevant issue, an unload file is provided. Unload files introduced in earlier patches are also included 
in this cumulative release. If you have not already applied them for a previous patch, you should 
also apply the unload files that are intended for your applications version. For more details about 
these applications updates, see the Release Notes for those patches.
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This patch release includes the unload files that come with the server update. When you extract 
sm9.21.661-P8_<OS>.zip (or .tar), it will add the files to the following directory:

[SM Server Root]\platform_unloads ([SM Server Root]/platform_unloads)

Note: Unload files should be installed in their patch order. That is, those introduced in patch 1 
should be applied first, then those introduced in patch 2, and so on. However, unload files 
introduced in the same patch can be installed in a random order, unless otherwise specified.

Unload File Naming Convention
The unload files use the following naming convention: <CR_ID>_SMxxxPxx_SMxxx.unl, where:

 l <CR_ID>: The identification number of the applications defect that the unload file fixes. For 
example, QCCR1E12345. Note that this is always the number of the parent CR of a CR family 
(if any).

 l SMxxxPxx: The minimum Service Manager patch level that requires the unload file. For 
example, SM921P2, which means the unload file comes with the server updates in Service 
Manager 9.21 patch 2 and should be used for patch 2 or higher.

Note: Sometimes this portion contains an additional hot fix number, for example, 
SM711P16HF8. This example means the unload file is intended for Service Manager 7.11 
patch 16 Hot Fix 8 or higher.

 l SMxxx: The Service Manager applications version that requires the unload file. For example, 
SM711, which means the unload file is intended only for Service Manager applications version 
7.11.

Note: If the applications version suffix is omitted, the unload file is then intended for all 
applications versions compatible with the server version, unless otherwise specified. For 
example, for Service Manager server 9.21, the compatible applications versions are 7.11 
and 9.20.

New Application Updates Introduced in This Patch
The following table lists the new application updates introduced in this release.

Unload file

Used for 
applicatio
ns version
(s) Description

  No unload file is newly introduced in Service Manager 9.21 
patch 8.
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Application Updates in Previous Patches
The following table lists the unload files introduced in previous patch release.

Unload file

Introduced 
in 9.21 
patch

Used for 
applications 
version(s) Description

QCCR1E29881_
SM921P1.unl

P1 7.11 and 
9.20

Includes application changes to reduce 
database I/O on login.

QCCR1E57766_
SM921P1.unl

P1 7.11 and 
9.20

Includes application changes to reduce jgroups 
traffic on login.

QCCR1E59753_
SM921P2.unl

P2 7.11 and 
9.20

Includes application changes to fix the ToDo 
bar.

QCCR1E31545_
SM921P2_
SM711.unl

P2 7.11 Prevents backslashes included in a template 
from being duplicated in the output.

Note: This file is not required for 
Applications 7.00.

QCCR1E31545_
SM921P2_
SM920.unl

P2 9.20 Prevents backslashes included in a template 
from being duplicated in the output.

QCCR1E48580_
SM921P3_
SM711.unl

P3 7.11 Enables translation of Display/Value lists on 
dynamic forms. This is a required fix for the 
Export to Excel redesign.

QCCR1E48580_
SM921P3_
SM920.unl

P3 9.20 Enables translation of Display/Value lists on 
dynamic forms. This is a required fix for the 
Export to Excel redesign.

QCCR1E48513_
SM921P3_
SM711.unl

P3 7.11 Lists the records in the right group order when a 
record list is refreshed.

QCCR1E58562_
SM921P3_
SM711.unl

P3 7.11 Includes applications changes for Export to 
Excel redesign.

QCCR1E58562_
SM921P3_
SM920.unl

P3 9.20 Includes applications changes for Export to 
Excel redesign.

QCCR1E67610_
SM921P4.unl

P4 7.11 and 
9.20

Enables you to block potentially dangerous 
attachments.
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Unload file

Introduced 
in 9.21 
patch

Used for 
applications 
version(s) Description

QCCR1E67072_
SM921P4.unl

P4 7.11 and 
9.20

Enables you to improve the Knowledge 
Management update process (KMUpdate) 
performance.

QCCR1E67647_
SM921P5.unl

P5 7.11 and 
9.20

Updated the scmessage record from "Doc 
Engine call failed” to include the message 
number.

QCCR1E70163_
SM921P5_
SM711.unl

P5 7.11 Prevents the KMUpdate process from 
terminating when the Search Engine server is 
shut down or an indexing document error 
occurs.

QCCR1E70163_
SM921P5_
SM920.unl

P5 9.20 Prevents the KMUpdate process from 
terminating when the Search Engine server is 
shut down or an indexing document error 
occurs.

QCCR1E71099_
SM921P6_
SM711.unl

P6 7.11 Enables the Value Lists to be displayed instead 
of the data directly retrieved from the database 
in a QBE list when adding a field by using 
Modify Columns.  

QCCR1E71099_
SM921P6_
SM920.unl

P6 9.20 Enables the Value Lists to be displayed instead 
of the data directly retrieved from the database 
in a QBE list when adding a field by using 
Modify Columns. 

Applying Unload Files

Tip: If your application version is 7.11 ap3, 9.21 ap3, 9.30 ap3, 9.31 or later, you are 
recommended to use Unload Manager to load an unload file, because Unload Manager can 
help you create a backup of your old data and reconcile conflicts during the installation of the 
unload; if your application version is other than any of these, Unload Manager is not available 
and you can use Database Manager instead. 

To load an unload file using Unload Manager:

 1. Go to System Administration > Ongoing Maintenance > Unload Manager.

 2. Double-click Apply Unload. A wizard opens.

 3. Select the unload file you want to apply, also specify a backup file, and then click Next. Details 
of the unload file appear.
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 4. Double-click a conflicting object in the table to open the merge tool:

 a. Merge the object, and then select the Reconciled check box.

 b. Click Save to go back to the wizard.

 5. Click Next after all the conflicting objects are reconciled.

 6. Click Yes on the confirmation window to apply the unload.

 7. Click Finish. 

Now, the unload has been applied and at the same time your old data backed up.

To load an unload file using Database Manager:

 1. Make sure the Windows client is configured for server-side load/unload.

 a. From the Windows client, go to Window > Preferences > HP Service Manager.

 b. Unselect Client Side Load/Unload if is flagged.

 c. Restart the Windows client.

 2. Open Tailoring > Database Manager.

 3. Right-click the form or open the More Actions menu and select Import/Load.

 4. Browse to the unload file, and view the contents of an unload file before importing it by clicking 
List Contents.

 5. Make a backup copy of all files to be modified by this unload. For detailed steps, see "Backout 
Instructions" on page 23.

HP Service Manager (9.21) Page 39 of 43

Patch 8 Release Notes
Installation Notes



 6. Fill in the following fields.

Field Description

File Name Type the name and path of the file to 
load.

Import Descriptor Since unload files do not require an 
Import Descriptor record, leave this 
field blank.

File Type Select the source operating system 
of the unload file.

Messages Option —
All Messages

Select this option to see all 
messages that Service Manager 
generates loading the file.

Messages Option — 
Totals Only

Select this option to see only the total 
number of files Service Manager 
loads.

Messages Option — 
None

Select this option to hide all 
messages that Service Manager 
generates when loading the file.

 7. Click Load FG.

ODBC Driver Update Installation

Note: This release does not contain any ODBC Driver update. The latest ODBC Driver patch 
has been shipped with the SM9.21p6 release, which you can download from 
http://support.openview.hp.com/selfsolve/document/KM00234051

The ODBC Driver update contains the following updated files:

 l Scodbc32.dll

 l sci18n.dll

 l sccl32.dll

To install the ODBC Driver update:

 1. Extract the files to your ODBC Driver installation folder, for example: C:\Program 
Files\Peregrine Systems\ServiceCenter 6.2\ODBC Driver.

 2. When prompted, replace the three old DLL files with the new ones.

HP Service Manager (9.21)Page 40 of 43

Patch 8 Release Notes
Installation Notes

http://support.openview.hp.com/selfsolve/document/KM00234051


Knowledge Management Import Utility Update 
Installation

Note: This release does not contain any Knowledge Management update. The latest 
Knowledge Management Import Utility patch has been shipped with the SM9.21p7 release, 
which you can download from: 

http://support.openview.hp.com/selfsolve/document/KM00438944

To install the knowledge Management Import Utility Update:

 1. Extract km-import-9.21.zip in the Knowledge Management package (sm9.21.624-P7_
KM.zip) to a local drive.

 2. For detailed instructions on the use of the import utility, see the README file packaged in the 
km-import-9.21.zip file.
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Service Manager Verified Environments
The Compatibility Matrix lists supported versions of operating systems, browsers, HP Software 
products, and other compatibility and support information.

Note: Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require an active support contract. To find more information about support access levels, go to      
Access levels.

To register for an HP Passport ID, go to      HP Passport Registration.

To access the Compatibility Matrix:

 1. Use a browser to navigate to the Software Support Online (SSO) web page:

http://support.openview.hp.com/sc/support_matrices.jsp

 2. Log on with your Customer ID and password or your HP Passport sign-in.

 3. Navigate to the applicable information.
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Local Language Support
UTF-8 is part of the Unicode standard, which enables you to encode text in practically any script 
and language. Service Manager 9.21 supports UTF-8 as an encoding method for new or existing 
data. It can support multiple languages that adhere to the Unicode standard on the same server.

Service Manager 9.21 or later does not provide language packs. A language pack of Service 
Manager 9.20 is available for each of the following languages: Japanese, French, Italian, German, 
Spanish, Korean, Russian, Brazilian Portuguese (UI only), Dutch (UI only), Polish (UI only), Czech 
(UI only), Hungarian (UI only), and Simplified Chinese.

Service Manager 9.21 or later can only work with Service Request Catalog (SRC) 1.20, which is 
English only.
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